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You are free:

e to copy, distribute, display, and perform the work
e to make derivative works

Under the following conditions:

@ Attribution. You must attribute the work in the manner specified
by the author or licensor.

Noncommercial. You may not use this work for commercial
purposes.

Share Alike. If you alter, transform, or build upon this work, you
may distribute the resulting work only under a license identical to

this one.

e For any reuse or distribution, you must make clear to others the license terms of

this work.
¢ Any of these conditions can be waived if you get permission from the copyright

holder.
Your fair use and other rights are in no way affected by the above.

This is a human-readable summary of the Legal Code (the full license) at the end
of this document.
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About @ONE

As California’s community colleges take on the challenge of effectively integrating
technology into instruction and services, they do so with the goals of increased student
access and improved student outcomes. The @ONE project has been funded by the
California Community Colleges Chancellor’s Office to build a statewide training
infrastructure with an electronic learning community as an integral support and
connection for faculty throughout the state. The @ONE project is a faculty driven
community college consortium that is dedicated to providing resources to community
college faculty and staff to support learning and students in the 21st century.

@ONE Mission

The mission of @ONE is to assist California Community College faculty and staff to
enhance student learning and success through expanded uses of effective technology
by providing training, online resources and support.

About this Guide

This booklet contains information about working with tables in Word 2003 and assumes
familiarity with the Windows operating system and Microsoft Word 2003.

Permission to Use & Reprint @ONE Training Materials

Modification, reprinting and distribution of these training materials throughout the
California Community College system is authorized and encouraged, provided that
@ONE is acknowledged as the original author (e.g. add this line before reprinting:
"These training materials adapted with permission from @ONE, http://one.evc.edu,
[date]™).

If you are outside the California Community College system and wish to use/adapt any
@ONE training materials, please contact the @ONE Office at 408.274.7900 ext. 6534,
or write to one@evc.edu, to make arrangements.

Copyright © 2005, @ONE, California Community Colleges
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Overview

Tables are mainly used to organize information on your page and are made up of rows
and columns that can be filled with text, numbers and graphics.

There are two ways to add tables to your document: insert a table or draw a table.
Inserting tables is the best choice when creating simple tables with consistent row and
column size. The Draw Table feature is good for creating complex tables. Each box
within your table is referred to as a cell.

A simple table created using the A complex table created using the Draw Table
Insert command. feature.

Once you create a table in your document, either by drawing or inserting, you can easily
manage that table with the Tables toolbar.

Inserting Tables

1. Go to the Table pull-down menu and select

Insert->Table. The Insert Table dialogue box will x|
appeal’ Table so= _
2. Specify the number of rows and columns you rhaler f okmies : 5‘
want in the appropriate boxes by either typing in femizef o e =
the number or using the up and down arrows to i
¥ Fixed column pidth: At =

the right of the boxes. R i
3. Choose an AutoFit behavior, if necessary: Ak o e
Table style: Table Grid AutoFoemat..
Fixed Column Width: You can specify the width of
each column or leave it to auto. This will
automatically set your columns to be spread
[ Remember dmergions for nes tables

evenly within your margins. T el

AutoFit to contents: Your columns’ width will change depending on the content of
each column and will stretch to fit that content.

AutoFit to window: Your column widths will be spread evenly within your margins.

4. Click OK. Your table will appear in your document.
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Drawing Tables

1. Go to the Table pull-down menu and select Draw Table. The Tables and Borders
Toolbar will appear and a pencil will already be selected. s and B

2. Place your pointer over a blank area in your document. :
Click and hold down with your mouse and drag diagonally | = - || - B G A LG gL R =
and to the right to create the outside border for your table.

3. Click and drag from the left to right side of your table to create
rows.

4. Click and drag from the top to bottom of your table to create
columns. L 5

5. If you make a mistake, click on the eraser button in your Table and
Borders toolbar, and then click and drag over the line you want to
erase. You will need to click on the pencil again in order to resume i
drawing lines.

6. When you are finished click on the pencil or eraser tool (whichever
;);beleyou were last using) to drop that tool and start typing in your ._-f

Draw Table Eraser

Typing and Navigating
You type in a table as you would in any other part of a Word document. You can format

your text using Formatting toolbar. You can also insert pictures, bullets and numbers in a
table as you would in any other part of a document.

Navigational Techniques
There are some basic navigational techniques you need to know when using tables:

e Click in a cell to place your insertion point there.

e Use your Tab key or your left and right arrows to move across from cell to cell.
Note: clicking Tab when your insertion point is in the last cell of your table will
add another row to your table.

e Use your up and down arrows to move up and down in your cells.

e If you want to indent in your cell, press Ctrl + Tab.

e To highlight cells in your table, click and hold down in a cell and then drag until all
the cells you want selected are highlighted.

e To select your entire table, click and hold down in the upper left corner cell then
drag down to the last cell in your table. Your entire table will be highlighted.

You can also click on the Move tool and your table will be selected (see next
page).
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Resizing and Moving Tables, Columns and Rows

Resizing and Moving Your Entire Table

1. Place your mouse over your table or click in your table. The Move and Resize
tools will appear.

Move tool. | —»

Click and

drag this to

move your :

table. +— R¢5|ze tool.
Click and drag

to resize your
table.

2. Click on the Move tool and drag to place your table in a different location on your

page.
3. Click on the Resize tool and drag to make your table larger or smaller.

Resizing Columns and Rows

1. Rest your pointer on the column or row you want to change the +||+
width/height of until you see the resize icon appear.

2. Click and hold down with your mouse and drag your row/column line to 2t

the desired position. ¥

Note: If you have a portion of your table selected when you increase/decrease

columns width and row height, only the selected portion will change.
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Modifying Tables with the Tables & Borders Toolbar

The Tables and Borders Toolbar allows you to easily change aspects about your table. If
you do not see the Table toolbar on your screen, go to View->Toolbars—>Tables and
Borders.

Tables and Borders
el —— 5 vrselrl B
H-EE B0 Al i =

Changing Border Style and Color

By default, your table will have black, thin border lines. You can change your border in
two ways: before you draw your table or after you draw/insert your table.

The Border Tools are as follows:

e Changes Line Style | ——— [~
e Changes Line Weight H
e Changes Border Color P -

To Change Your Border Before You Draw a Table
1. Click on the Line Style menu and select a line style.
2. Click on the Line Weight menu and choose a thickness.
3. Click on the Border Color button and choose a line color.
4. Click on the Draw Table tool, if necessary, and begin drawing the lines of your
table.

To Change Your Border After You Insert/Draw a Table
1. Highlight your table or the area in your table where you want to change the
border by clicking and dragging over your table with your mouse.
Click on the Line Style menu and select a line style.
Click on the Line Weight menu and select a line thickness.
Click on the Border Color button and choose a line color.
Click on the Outside Border button and choose the borders you want to apply
your modifications to.

abrown
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Changing Fill Color

By default, the background color for the cells in your table is white. To change

background color:
1. Highlight the cells in your table that you want to change.
2. Click on the Shading Color button in the Tables and Borders toolbar

and select a new background color.

Sy -

Adding Rows and Columns and Changing AutoFit Behavior

You can easily add rows and columns and change the AutoFit behavior of a table within
the Tables and Borders toolbar.

1. Click in your table. Your insertion point must be in a cell in your table in order for
changes to take affect.

2. Click on the arrow next to the Insert Table button in the lower left -
corner of your Tables and Border Toolbar. The look of this button will
change depending on the last command you chose.

3. Choose the appropriate command.

Merging and Splitting Cells
To Merge Cells Together

1. Highlight the cells in your table you want to merge. =
2. Click on the Merge Cells button. The cells you selected will merge
together.
To Split Cells
1. Highlight the cell(s) you want to split. iE=:|

2. Click the Split Cells button.
3. Specify the number of rows or columns you want the cell split into.
4.

Click OK.
Split Cells X
Mumber of columns; lﬂ E‘ I

Mumber of roves:

¥ Merge cells befare split

(04 I Cancel |

Aligning Text within Tables
You can vertically and horizontally align text within your table using

button in the Tables and Borders toolbar. = =i
1. Highlight the cell(s) where you want to change the text =]
alignment. SlE 5

2. Click the Alignment button and choose a different alignment Sl
from the menu that appears.

(c) 2005 @ONE http://one.evc.edu



Distributing Columns and Rows

When you insert a table into your document, by default, the columns and rows are
distributed evenly. When you draw a table, you may want to use the Distribution buttons
in order to spread the columns and rows evenly within your table.

If your table is too complex, you will receive an error message stating that Word was
unable to distribute the rows/columns.

Distribute Rows and Columns Evenly
1. Highlight the rows/columns you want to even out.

. o o Bt &5
2. Click on the Distribute Rows Evenly and/or Distribute Columns t
Evenly button.

Table AutoFormat

Word has set up a variety of table layouts you can use to easily apply design and color

to your tables. You can apply Table AutoFormats when you insert a table or after you
insert/draw a table.

Applying an AutoFormat to an Existing Table
1. Click in a cell in your table or highlight your table. #

2. Click on the Table AutoFormat button. The Table AutoFormat dialogue
box will appear.

Table AutoFormat x|
Category:
Table styles:
Tank Classic 4 .
Tale Colarful 1 S
Taile Colorful 2 ~
T:‘:ﬂa cdz:ftl 3 J Creiete
Tank Columns 1
Tabk Columns 2
Tabke Celumne 5
I:»':IE ':.'E‘\lurnrs 4q
Tk Columns §
reble Ew:‘.cm;:nay HodFy...
Tabk: Elsﬁt - A
Prenvigw
Tan Fek Tular Tatal
W st & 4 7 17
South |8 7 4 24
Tatal 21 12 21 &0

Appky speoal formats to

¥ Heading rows [¥ Last raw
I¥ Fst cghumn [¥ Last column

|gppr|r|-:mn=||

3. Choose a format from the list at the left (preview appears in box on right).

4. Choose which parts of the format you don’t want to apply by unchecking the
boxes in the bottom half of the dialog box.

5. To select from additional formatting options, click on the Modify button, and

choose your table formatting settings. Click OK when you are finished.
6. Click Apply.

(c) 2005 @ONE http://one.evc.edu 6



Applying an AutoFormat as You Insert a Table

Go to Table=>Insert->Table.

Make your specifications in the window that appears.

Click the Table AutoFormat button.

Use the steps on page 6 to apply AutoFormatting.

Click Apply in the Table AutoFormat dialogue box and OK in the Table dialogue
box.

arwdE

Changing Text Direction
You can change the text direction in any cell of your table.

1. Highlight the cells in your table where you want to change the text direction.

2. Click the Change Text Direction button. This will rotate your text 90° i
clockwise. Clicking on the button a second time will rotate your text i
another 180° clockwise. Clicking a third time will return your text to its original

position.
i ey | Tuesday | Wedtwsday | Thamsday | Friday
ARERERRRE
g5 g AE I
£ HEERH
First Click Second Click Third Click

NOTE: If you do not choose the AutoFit to Contents option (see pages 1 and 5)
before changing text direction, you may need to resize your row height to
accommodate your rotated text (see page 3).

Sorting

You can sort the data in your worksheet by ascending or descending order. You can sort
using the buttons in the Standard Toolbar or using the Sort command in the Data pull-
down menu. The buttons in the Standard Toolbar are used when sorting information in
worksheets that have header columns. The Sort command can be used either for
worksheets with header columns or simple lists that do not have header columns.

Fartridge Danny 13|Red Hazel
Adams Wednesday 9|Brown BErown
Brady Cindy E|Blonde Blue

A list without headers: If you used the buttons in the Standard toolbar to sort a list like
this, Excel assumes that the top row is your header row and will not sort it. Therefore, in
this example, Partridge would not be sorted with the list.

Last Name [First name Age Hair Eyes
Farridge Danny 13 Red Hazel
Adams WwWednesday 4 Brown Brown
Brady Cindy a] Blonde Blue

A list with a header row: If you used the buttons in the Standard Toolbar to sort a list like
this, Excel assumes that the top row is your header row and will not sort it, which you
would want in this case.

(c) 2005 @ONE
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Using the Sort Command

1. Click in the first cell of your table (upper left cell).

2. Go to the Table menu and select Sort.
3. Inthe Sort dialogue box that appears, specify

how you want to sort your list (by which column).
4. On the bottom of the dialogue box, specify

whether or not your list contains a header row.
5. For additional options, click on the Options

button, and select your sort options in the Sort

Options dialogue that appears. Then click OK.
6. Click OK in the Sort dialogue box.

Using the Sort Buttons
1. Click the first name, number, and other text in the cell you want to sort by. For
instance, if you want to sort by your Last Name column, click on the first last

name in that list.

5
Sart by = =
: i+ pacersd
=] Teme ITB‘X: ﬂ f“ism-;':g
Lsing; |F‘nrnr_;m|'f, ﬂ
Then by -
% Ascend
| [ 2 rm#m::g
Using: [Paragraphs =]
Then by &
¥ Oscerding
e B
15ing i'l"‘: . alr j
My list has
" Hoader row % ho header row
IO .. | oK I Cancel

2. Click on either the Sort Ascending or Sort Descending button in your
Standard Toolbar.

AutoSum

2 &4

You can add a row or column of numbers in your table using the AutoSum button.
1. Click in the cell below the column of numbers or in the cell to the right of the row

of numbers you want to add.

2. Click the AutoSum button. The numbers will be added and the result will ¥
appear in the cell.
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@creat ive
/commons

Attribution-NonCommercial-ShareAlike 2.5

CREATIVE COMMONS CORPORATION IS NOT A LAW FIRM AND DOES NOT
PROVIDE LEGAL SERVICES. DISTRIBUTION OF THIS LICENSE DOES NOT
CREATE AN ATTORNEY-CLIENT RELATIONSHIP. CREATIVE COMMONS
PROVIDES THIS INFORMATION ON AN "AS-IS" BASIS. CREATIVE COMMONS
MAKES NO WARRANTIES REGARDING THE INFORMATION PROVIDED, AND
DISCLAIMS LIABILITY FOR DAMAGES RESULTING FROM ITS USE.

License

THE WORK (AS DEFINED BELOW) IS PROVIDED UNDER THE TERMS OF THIS
CREATIVE COMMONS PUBLIC LICENSE ("CCPL" OR "LICENSE"). THE WORK IS
PROTECTED BY COPYRIGHT AND/OR OTHER APPLICABLE LAW. ANY USE OF
THE WORK OTHER THAN AS AUTHORIZED UNDER THIS LICENSE OR
COPYRIGHT LAW IS PROHIBITED.

BY EXERCISING ANY RIGHTS TO THE WORK PROVIDED HERE, YOU ACCEPT
AND AGREE TO BE BOUND BY THE TERMS OF THIS LICENSE. THE LICENSOR
GRANTS YOU THE RIGHTS CONTAINED HERE IN CONSIDERATION OF YOUR
ACCEPTANCE OF SUCH TERMS AND CONDITIONS.

1. Definitions

a.

f.

"Collective Work" means a work, such as a periodical issue, anthology or
encyclopedia, in which the Work in its entirety in unmodified form, along with a
number of other contributions, constituting separate and independent works in
themselves, are assembled into a collective whole. A work that constitutes a
Collective Work will not be considered a Derivative Work (as defined below) for
the purposes of this License.

"Derivative Work" means a work based upon the Work or upon the Work and
other pre-existing works, such as a translation, musical arrangement,
dramatization, fictionalization, motion picture version, sound recording, art
reproduction, abridgment, condensation, or any other form in which the Work
may be recast, transformed, or adapted, except that a work that constitutes a
Collective Work will not be considered a Derivative Work for the purpose of this
License. For the avoidance of doubt, where the Work is a musical composition or
sound recording, the synchronization of the Work in timed-relation with a moving
image ("synching") will be considered a Derivative Work for the purpose of this
License.

"Licensor" means the individual or entity that offers the Work under the terms of
this License.

"Original Author" means the individual or entity who created the Work.

"Work" means the copyrightable work of authorship offered under the terms of
this License.

"You" means an individual or entity exercising rights under this License who has
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not previously violated the terms of this License with respect to the Work, or who
has received express permission from the Licensor to exercise rights under this
License despite a previous violation.

"License Elements" means the following high-level license attributes as
selected by Licensor and indicated in the title of this License: Attribution,
Noncommercial, ShareAlike.

2. Fair Use Rights. Nothing in this license is intended to reduce, limit, or restrict any
rights arising from fair use, first sale or other limitations on the exclusive rights of the
copyright owner under copyright law or other applicable laws.

3. License Grant. Subject to the terms and conditions of this License, Licensor hereby
grants You a worldwide, royalty-free, non-exclusive, perpetual (for the duration of the
applicable copyright) license to exercise the rights in the Work as stated below:

a.

to reproduce the Work, to incorporate the Work into one or more Collective
Works, and to reproduce the Work as incorporated in the Collective Works;

to create and reproduce Derivative Works;

to distribute copies or phonorecords of, display publicly, perform publicly, and
perform publicly by means of a digital audio transmission the Work including as
incorporated in Collective Works;

to distribute copies or phonorecords of, display publicly, perform publicly, and
perform publicly by means of a digital audio transmission Derivative Works;

The above rights may be exercised in all media and formats whether now known or
hereafter devised. The above rights include the right to make such modifications as are
technically necessary to exercise the rights in other media and formats. All rights not
expressly granted by Licensor are hereby reserved, including but not limited to the rights
set forth in Sections 4(e) and 4(f).

4. Restrictions. The license granted in Section 3 above is expressly made subject to
and limited by the following restrictions:

a.

You may distribute, publicly display, publicly perform, or publicly digitally perform
the Work only under the terms of this License, and You must include a copy of,
or the Uniform Resource Identifier for, this License with every copy or
phonorecord of the Work You distribute, publicly display, publicly perform, or
publicly digitally perform. You may not offer or impose any terms on the Work
that alter or restrict the terms of this License or the recipients' exercise of the
rights granted hereunder. You may not sublicense the Work. You must keep
intact all notices that refer to this License and to the disclaimer of warranties. You
may not distribute, publicly display, publicly perform, or publicly digitally perform
the Work with any technological measures that control access or use of the Work
in a manner inconsistent with the terms of this License Agreement. The above
applies to the Work as incorporated in a Collective Work, but this does not
require the Collective Work apart from the Work itself to be made subject to the
terms of this License. If You create a Collective Work, upon notice from any
Licensor You must, to the extent practicable, remove from the Collective Work
any credit as required by clause 4(d), as requested. If You create a Derivative
Work, upon notice from any Licensor You must, to the extent practicable, remove
from the Derivative Work any credit as required by clause 4(d), as requested.
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b. You may distribute, publicly display, publicly perform, or publicly digitally perform
a Derivative Work only under the terms of this License, a later version of this
License with the same License Elements as this License, or a Creative
Commons iCommons license that contains the same License Elements as this
License (e.g. Attribution-NonCommercial-ShareAlike 2.5 Japan). You must
include a copy of, or the Uniform Resource Identifier for, this License or other
license specified in the previous sentence with every copy or phonorecord of
each Derivative Work You distribute, publicly display, publicly perform, or publicly
digitally perform. You may not offer or impose any terms on the Derivative Works
that alter or restrict the terms of this License or the recipients' exercise of the
rights granted hereunder, and You must keep intact all notices that refer to this
License and to the disclaimer of warranties. You may not distribute, publicly
display, publicly perform, or publicly digitally perform the Derivative Work with
any technological measures that control access or use of the Work in a manner
inconsistent with the terms of this License Agreement. The above applies to the
Derivative Work as incorporated in a Collective Work, but this does not require
the Collective Work apart from the Derivative Work itself to be made subject to
the terms of this License.

c. You may not exercise any of the rights granted to You in Section 3 above in any
manner that is primarily intended for or directed toward commercial advantage or
private monetary compensation. The exchange of the Work for other copyrighted
works by means of digital file-sharing or otherwise shall not be considered to be
intended for or directed toward commercial advantage or private monetary
compensation, provided there is no payment of any monetary compensation in
connection with the exchange of copyrighted works.

d. If you distribute, publicly display, publicly perform, or publicly digitally perform the
Work or any Derivative Works or Collective Works, You must keep intact all
copyright notices for the Work and provide, reasonable to the medium or means
You are utilizing: (i) the name of the Original Author (or pseudonym, if applicable)
if supplied, and/or (ii) if the Original Author and/or Licensor designate another
party or parties (e.g. a sponsor institute, publishing entity, journal) for attribution
in Licensor's copyright notice, terms of service or by other reasonable means, the
name of such party or parties; the title of the Work if supplied; to the extent
reasonably practicable, the Uniform Resource Identifier, if any, that Licensor
specifies to be associated with the Work, unless such URI does not refer to the
copyright notice or licensing information for the Work; and in the case of a
Derivative Work, a credit identifying the use of the Work in the Derivative Work
(e.g., "French translation of the Work by Original Author," or "Screenplay based
on original Work by Original Author"). Such credit may be implemented in any
reasonable manner; provided, however, that in the case of a Derivative Work or
Collective Work, at a minimum such credit will appear where any other
comparable authorship credit appears and in a manner at least as prominent as
such other comparable authorship credit.

e. Forthe avoidance of doubt, where the Work is a musical composition:

i. Performance Royalties Under Blanket Licenses. Licensor reserves the
exclusive right to collect, whether individually or via a performance rights
society (e.g. ASCAP, BMI, SESAC), royalties for the public performance
or public digital performance (e.g. webcast) of the Work if that
performance is primarily intended for or directed toward commercial
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advantage or private monetary compensation.

ii.  Mechanical Rights and Statutory Royalties. Licensor reserves the
exclusive right to collect, whether individually or via a music rights agency
or designated agent (e.g. Harry Fox Agency), royalties for any
phonorecord You create from the Work ("cover version") and distribute,
subject to the compulsory license created by 17 USC Section 115 of the
US Copyright Act (or the equivalent in other jurisdictions), if Your
distribution of such cover version is primarily intended for or directed
toward commercial advantage or private monetary compensation.

f. Webcasting Rights and Statutory Royalties. For the avoidance of doubt,
where the Work is a sound recording, Licensor reserves the exclusive right to
collect, whether individually or via a performance-rights society (e.g.
SoundExchange), royalties for the public digital performance (e.g. webcast) of
the Work, subject to the compulsory license created by 17 USC Section 114 of
the US Copyright Act (or the equivalent in other jurisdictions), if Your public
digital performance is primarily intended for or directed toward commercial
advantage or private monetary compensation.

5. Representations, Warranties and Disclaimer

UNLESS OTHERWISE MUTUALLY AGREED TO BY THE PARTIES IN WRITING,
LICENSOR OFFERS THE WORK AS-IS AND MAKES NO REPRESENTATIONS OR
WARRANTIES OF ANY KIND CONCERNING THE WORK, EXPRESS, IMPLIED,
STATUTORY OR OTHERWISE, INCLUDING, WITHOUT LIMITATION, WARRANTIES
OF TITLE, MERCHANTIBILITY, FITNESS FOR A PARTICULAR PURPQOSE,
NONINFRINGEMENT, OR THE ABSENCE OF LATENT OR OTHER DEFECTS,
ACCURACY, OR THE PRESENCE OF ABSENCE OF ERRORS, WHETHER OR NOT
DISCOVERABLE. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF
IMPLIED WARRANTIES, SO SUCH EXCLUSION MAY NOT APPLY TO YOU.

6. Limitation on Liability. EXCEPT TO THE EXTENT REQUIRED BY APPLICABLE
LAW, IN NO EVENT WILL LICENSOR BE LIABLE TO YOU ON ANY LEGAL THEORY
FOR ANY SPECIAL, INCIDENTAL, CONSEQUENTIAL, PUNITIVE OR EXEMPLARY
DAMAGES ARISING OUT OF THIS LICENSE OR THE USE OF THE WORK, EVEN IF
LICENSOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

7. Termination

a. This License and the rights granted hereunder will terminate automatically upon
any breach by You of the terms of this License. Individuals or entities who have
received Derivative Works or Collective Works from You under this License,
however, will not have their licenses terminated provided such individuals or
entities remain in full compliance with those licenses. Sections 1, 2, 5, 6, 7, and 8
will survive any termination of this License.

b. Subject to the above terms and conditions, the license granted here is perpetual
(for the duration of the applicable copyright in the Work). Notwithstanding the
above, Licensor reserves the right to release the Work under different license
terms or to stop distributing the Work at any time; provided, however that any
such election will not serve to withdraw this License (or any other license that has
been, or is required to be, granted under the terms of this License), and this
License will continue in full force and effect unless terminated as stated above.
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8. Miscellaneous

a. Each time You distribute or publicly digitally perform the Work or a Collective
Work, the Licensor offers to the recipient a license to the Work on the same
terms and conditions as the license granted to You under this License.

b. Each time You distribute or publicly digitally perform a Derivative Work, Licensor
offers to the recipient a license to the original Work on the same terms and
conditions as the license granted to You under this License.

c. If any provision of this License is invalid or unenforceable under applicable law, it
shall not affect the validity or enforceability of the remainder of the terms of this
License, and without further action by the parties to this agreement, such
provision shall be reformed to the minimum extent necessary to make such
provision valid and enforceable.

d. No term or provision of this License shall be deemed waived and no breach
consented to unless such waiver or consent shall be in writing and signed by the
party to be charged with such waiver or consent.

e. This License constitutes the entire agreement between the parties with respect to
the Work licensed here. There are no understandings, agreements or
representations with respect to the Work not specified here. Licensor shall not be
bound by any additional provisions that may appear in any communication from
You. This License may not be modified without the mutual written agreement of
the Licensor and You.

Creative Commons is not a party to this License, and makes no warranty whatsoever in
connection with the Work. Creative Commons will not be liable to You or any party on
any legal theory for any damages whatsoever, including without limitation any general,
special, incidental or consequential damages arising in connection to this license.
Notwithstanding the foregoing two (2) sentences, if Creative Commons has expressly
identified itself as the Licensor hereunder, it shall have all rights and obligations of
Licensor.

Except for the limited purpose of indicating to the public that the Work is licensed under
the CCPL, neither party will use the trademark "Creative Commons" or any related
trademark or logo of Creative Commons without the prior written consent of Creative
Commons. Any permitted use will be in compliance with Creative Commons' then-
current trademark usage guidelines, as may be published on its website or otherwise
made available upon request from time to time.

Creative Commons may be contacted at http://creativecommons.org/.
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